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Contact and Support Information
Return to Table of Contents.

Product information can be accessed by visiting Customer Support online: CCH Axcess Product Support.

In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility for each CCH Axcess™ module. Access to these features is available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes.

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to open a Support case or chat with a representative for assistance.
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https://support.cch.com/productsupport/productsupport.aspx?id=37
https://support.cch.com/Axcess/ReleaseNotes/Tax
https://support.cch.com/Notes/appStatus.aspx?type=SaaS&amp;prodid=934
https://support.cch.com/Contact


Information in Tax Release Notes
Return to Table of Contents.

CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that were made to Tax
products and systems with the current release.

Information provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (such as, electronic filing updates, Organizer, Roll Forward, and
technology enhancements)
Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2020-4.2
Return to Table of Contents

Tax Updates

Individual, Partnership, Corporation, S Corporation, Fiduciary, Tax Exempt
Form 3115. New DCN codes 246 and 247 have been added to Part 1, Line 1a. Part II Lines 11, 12, 13, 15,
16, 17 and 19 are now blank when codes 246 or 247 are used, per Rev. Proc. 2020-50.

Minnesota. Minnesota passed legislation July 1, 2021, that included retroactive conformity provisions.
Updated forms were received from Minnesota, and this version contains these updates.

Individual and Fiduciary
QBI Loss Tracking Worksheet. The worksheet now prints with Forms 8995/8995-A if there are loss
carryovers, providing detailed tracking of those losses. The worksheet also contains cross-references, so
you can refer back to data sources. The worksheet is not filed with the IRS, and is intended for record
keeping purposes only. When QBI losses and carryovers differ from the activity, the differences show as
NonQBI in Part II of the QBI Loss Tracking Worksheet to allocate the allowed loss between NonQBI (Part II)
and QBI (Part III). Please refer to the following knowledge base article for the latest updates and
information about the QBI Loss Tracking Worksheet.

2020 Individual Return - Form 8995 and 8995-A Changes

2020 Fiduciary Return - Form 8995 and 8995-A Changes

Partnership and S Corporation
Maryland Forms 510 and 511. As you know, we introduced Maryland Form 511 in our 2020-4.1 release on
July 25 and also provided updates in a special release, 2020-4.1.1. We continue to receive additional
information from Maryland, clarifying calculations on both Form 510 and Form 511; those updates are
included in this release.

Electronic Filing Updates

Individual

Kentucky Amended e-file for Forms 740 and 740NP is now available.

S Corporation

New Jersey CBT-100U is now available.
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https://www.irs.gov/pub/irs-drop/rp-20-50.pdf
https://support.cch.com/kb/solution/000121259/2020-1040-Individual-Return-Form-8995-and-8995-A-Changes
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Issues Resolved
Return to Table of Contents.

The following issues were resolved with release 2020-4.2:

Signature block data. The Data Migration issue has been resolved. All data from the firm’s signature block
is now migrating from CCH ProSystem fx Tax to CCH Axcess Tax.
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Tax Product Updates

Individual (1040) Product Updates
Return to Table of Contents.

Federal
Form 1116 AMT. No current year AMT foreign tax credit carryover is calculated when the election to claim
the foreign tax credit without filing Form 1116 is made on the following:

Foreign Tax Credit > Processing Options > Election to claim the foreign tax credit without
filing Form 1116 field

Interest (IRS 1099-INT) > Foreign Account Information > Form 1116 / 1116 AMT processing code
field

Dividends (IRS 1099-DIV) > Foreign Account Information > Form 1116 / 1116 AMT processing
code field

Consolidated 1099 > Foreign Account Information > Form 1116 / 1116 AMT processing code
field

Form 3115. DCN codes 246 and 247 have been added to Part 1, Line 1a. Part II Lines 11, 12, 13, 15, 16, 17
and 19 are now blank when codes 246 or 247 are used, per IRS Rev. Proc. 2020-50.

Form 3520-A. Form 3520-A, Page 4, Lines 4 and 7 no longer add zeros to the amount.

Form 4952 AMT. Depreciation recapture from the sale of home shown on Form 4797, Part III is now
included in Line 4d, Net gain from the disposition of property held for investment.

Form 8283. Section B, Part I, Columns G and H are blank instead of printing zero when no entry is made.

Form 8990 Schedule A. The expected amount of current year Excess Business Interest Expense will pull
from the Partnership K-1 Basis Limitation worksheet statement when the basis carryover for Excess
Business Interest Expense is greater than current year Excess Business Interest Expense from Line 13K of a
partnership Schedule K-1.

QBI Loss Tracking Worksheet. The worksheet now prints with Forms 8995/8995-A if there are loss
carryovers, providing detailed tracking of those losses. The worksheet is not filed with the IRS, and is
intended for record keeping purposes only. When QBI losses and carryovers differ from the activity, the
differences show as NonQBI in Part II of the QBI Loss Tracking Worksheet to allocate the allowed loss
between NonQBI (Part II) and QBI (Part III).

Please note: The changes in calculation to follow the new instructions could potentially cause
changes in returns that have partially disallowed losses showing on the 8995/8995-A as well as
on the carryover worksheets. Issues with passive loss carryovers were also addressed with this
release. When carryover overrides are used, the QBI Loss Tracking worksheet does not
generate; the QBI Carryover Detail worksheet should be used instead. Ordinary losses for
Schedules C, E and F will be added on a future release. Column D of the worksheet will not fill
at this time for passthroughs, but will be added on a future release.

For more information, refer to knowledge base article 2020 1040 Individual Return Form 8995
and 8995-A Changes.
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Electronic Filing
Form 8839. Disqualifying diagnostic 44360 is issued when child information is missing or for any child
shown on Form 8839 or when a child has not been listed on the form.

Alabama
Schedule D totals include input from Schedule D / 4797 / 4684 - Gains and Losses (1099-B, 1099-S, 2439),
Capital Gains and Losses, Adjustment - override.

Alabama Electronic Filing
Alabama Specialized Estimates are generated when Federal > Electronic Filing > General > Suppress
printing of e-file signature forms and payment vouchers on export is set to "N".

District of Columbia
The statement pertaining to Form DC D-40, Line 17 now properly reflects the additional deduction for
taxpayers age 65 or older.

The total payments and refundable credits on Form D-40 include the refund requested with the original
return and produces a statement detailing its inclusion in the calculation.

Idaho
For Idaho returns using Form 43, Line 34 now uses the amounts from the federal Form 1040-NR Schedule A.

Form 39R, Line 18 now matches the statement in returns where the medical expense deduction allowed
on federal Form 1040, Schedule A is less than the Idaho deduction allowed.

Illinois
Schedule CR.

Line 11, Column B now includes non-IL rental income/loss attributed to the spouse.

Line 7, Column B is limited to the amount in Line 7, Column A.

Schedule NR, Line 35, Column B now includes the federal charitable contributions from Form 1040, Line
10b.

Iowa
The Iowa Department of Revenue has updated the print format for the Iowa Penalty Wavier Request. The
form has been updated to reflect these changes.

Kentucky
Electronic filing of amended Forms 740 and 740NP is now available.

Louisiana
A statement for the amended explanation of changes has been added to Form IT-540-2D.

New input for the new Covid-19 Relief Benefits exemption is available on Louisiana > Income/Deductions >
Subtractions > Covid-19 Relief Benefits field.
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The late interest rate penalty has been updated to 6.5%.

Maryland
Form 500DM. Code L no longer produces a duplication of Form 461 amounts.

Michigan
Diagnostic 31783 no longer appears when federal Form 1045 is populated in the return.

Minnesota
Minnesota passed legislation July 1, 2021 that included retroactive conformity provisions. Updated forms
were received from Minnesota and the 2020 software reflects these updates. As a result:

Automatic calculations for Schedule M1NC, Lines 1, 4, 5, 7, and 9 have been removed and the
input that was in place for those lines as overrides will no longer be active.

Schedule M1SA will now allow the same limitation percentages as used on Federal.

The Section 179 expensing addition has been removed from Schedules M1M Line 4, M1NR Line
11, KPI Line 4 and KS Line 4.

Schedules KPINC, KSNC and KFNC:

have had Line 1 removed.

Section codes 9675, 9651, and 9641 have been added for Lines 2, 3, and 7.

TCDTR section codes 116, 117, 130 to 132, and 144 have been removed from Lines 8 and
9.

All prior section codes removed and one added (9673) to Line 15.

In addition, current year disaster contributions calculate with a 100% of AGI limitation percentage on the
Minnesota Charitable Contributions worksheet.

Mississippi
Mississippi letters now reflect the optimized tax amount without input.

Nebraska
The late filing interest rate penalty is 3 percent.

New Jersey
Part year resident calculation of the pension exclusion has been adjusted to disregard any losses present
for all source income on the Federal return. In some cases, this may result in the pension exclusion being
disallowed on the NJ return.

North Carolina
Dependent taxpayers who itemize Federal now see the regular nonzero standard deduction populate for
North Carolina.
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Ohio
Form NRC, Page 1 has been updated to print when taxpayer's spouse is part-year or non-resident and
taxpayer is a full-time resident of Ohio.

Ohio - Ohio Cities
All withholdings for the resident city are included in a part-year resident return when multiple resident
cities are being prepared.

Cincinnati. Additional input has been added for "Cincinnati non-taxable income (part-year or nonresidents
only)" before and after the date of rate change.

Generic Form R. When Schedule Y is present in a part year resident return, it only calculates based on the
period of non-residency.

Interest rates have been updated for the 2021 calendar year.

The following city updates have been made:

Joining RITA From Independent

BR14 Bryan
BU03 Butler
GI01 Gibsonburg
RI07 Rittman

Joining RITA From CCA

WE04 West Alexandria

Joining CCA From Independent

DA01 Dalton

Rate Change

CR03 Cridersville Effective 7/1/21
MI01 Midvale Effective 7/1/21
PO03 Powell Effective 1/1/22

New RITA City Codes

EV02 Evans Farm JEDD Effective 7/27/20
MI28 Milford JEDD VII Effective 2/1/21

Oregon
The ASC Code 107 addition for Federal election on interest and dividends of a minor child has been
updated from $1,050 to $1,100.

Virginia
Schedule A worksheet, Line 13 now calculates based on Virginia filing status, rather than Federal.
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Virginia Electronic Filing
Exception met boxes (electronic filing only) fill based on exceptions for Form 760C.
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Corporation (1120) Product Updates
Return to Table of Contents.

Federal
Form 1120.

A statement has been added for taxpayers electing out of the CARES Act net operating loss
provisions with respect to farm losses.

Investment interest expense from a pass-through entity designated as a non-passive activity
will be accounted for once per non-passive activity and will flow to Form 1120, Line 18.

Form 3115.

Change codes 246 and 247 are now available options, which can be selected on Other > 3115 -
Change in Accounting Method > Automatic Change Request.

DCN codes 246 and 247 have been added to Part 1, Line 1a. Part II Lines 11, 12, 13, 15, 16, 17
and 19 are now blank when codes 246 or 247 are used, per Rev. Proc. 2020-50.

Alabama
Alabama Corporation > Other Returns > Business Privilege Tax > Date of qualification or registration in AL
for foreign entities - override field has been added to allow Form BPT-IN, Line 6a to report a different date
than the date reported for Line 6c, Date started doing business.

The penalty and interest overrides on the Penalties > State/City Late Interest and Penalties > Detail can
now be used on Forms 20C, ET-1, CPT, BPT-IN, and 20C-C.

When the filing status on Form 20C is 1. Corporation operating only in Alabama, Line 10 will now calculate
based on the apportionment override entered and diagnostic 19219 will issue if the apportionment
percentage is other than 100%.

Florida
FL 1120, Page 3 now shows an addback for bonus depreciation for current year qualified improvement
property.

Florida now conforms with the federal provisions suspending the 80% of taxable income deduction limits
for net operating losses from the tax years 2018, 2019, and 2020.

Maine
Form 1120ME, Schedule C, Line 1t now equals Line 6c, Total Tax, on Page 1.

Michigan
Form 4908, Line 20 is now limited to zero if the amount calculated is less than or equal to $100.

Letters and filing instructions for Form 4892 now show the correct amounts for the balance due or refund
from the originally filed return.
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New Jersey
Form 100U, Page 26, Line 8a, Current tax year's PNOL deduction, has been corrected and now agrees with
the summary total on Line 8b and Schedule C, Line 1.

New York
The combined NOL allocation statements now match the amount reported on Form CT 3.4 under all
circumstances.

The default estimated capital tax computation has been updated for information applicable to cooperative
housing corporations.

North Carolina
Form CD-405, Page 2, Schedule G, Line 20a statement will now match the amount reported on the line
when negative depreciation is included in the total.

The amount paid with the franchise extension will now carry from the parent and subsidiary returns to the
consolidating unit's Form CD-405, Schedule A, Line 6. If the override on the Payments > State Quarterly
Payments > Detail > Extension Payments > Other extension payment is used, it will carry to the
consolidating unit from the lower level returns, or it can be used on the consolidated return.

Ohio - Ohio Cities
The following city updates have been made:

Joining RITA From Independent

BR14 Bryan
BU03 Butler
GI01 Gibsonburg
RI07 Rittman

Joining RITA From CCA

WE04 West Alexandria

Joining CCA From Independent

DA01 Dalton

Rate Change

CR03 Cridersville Effective 7/1/21
MI01 Midvale Effective 7/1/21
PO03 Powell Effective 1/1/22

New RITA City Codes

EV02 Evans Farm JEDD Effective 7/27/20
MI28 Milford JEDD VII Effective 2/1/21
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Oregon
Portland and Multnomah County Form BZT-V EST amounts now include the Heavy Vehicle Use Tax (HVT)
and the Pay Ratio Surtax (PRS).

Vermont
Form CO-414 estimate calculation includes the gross receipts on Form CO-411, Line 18.

Form CO-422 no longer prints if balance due is zero.

West Virginia Consolidated
Form UB-CR.

Line NOL 4 now calculates based on Lines 15, NOL 1, NOL 2 and NOL 3. If Line 15 is zero or a
negative number, then NOL 4 will be zero.

Pages 2 and 3 now have correct positioning when printed to PDF or paper.

Tax Product Updates • 13



S Corporation (1120S) Product Updates
Return to Table of Contents.

Federal
Form 3115. DCN codes 246 and 247 have been added to Part 1, Line 1a. Part II Lines 11, 12, 13, 15, 16, 17
and 19 are now blank when codes 246 or 247 are used, per IRS Rev. Proc. 2020-50.

Schedule K-1.

Gross receipts from a rental or royalty activity used in the calculation of Section 488(c) will be
multiplied by the ownership percentage, if entered, for that activity.

Section 448(c) gross receipts for the current year will not double count items from
passthroughs or include items entered as state only.

The QBI statement for Line 17V is generated when the total sum of all Qualified Business
Income items on the QBI worksheet is zero.

Schedule M-2, Line 1 and Line 9 will now have an option for override.

Electronic Filing
New Jersey CBT-100U is now available for electronic filing.

Alabama
Form 20S, Page 1, Short Year check box will now be checked when Short Year override on General >
General > Short year - Override field has been selected.

Georgia
Form 600S, Schedule 10, Line 13 now includes the credit used on Form IT-CR, Line 2.

Illinois
Illinois Schedule B. Foreign shareholders without a Social Security Number or employer identification
number will be able to file electronically if all zeros are entered.

Louisiana
Form CIFT-620, Sch E, Line 7 and Sch F, Line 3c now include the amount of interest income entered in
Income/Deductions > Partnership passthrough > Interest.

Maryland
As you know, we introduced Maryland Form 511 in our 2020-4.1 release on July 25 and also provided
updates in a special release, 2020-4.1.1. We continue to receive additional information from Maryland,
clarifying calculations on Forms 510 and 511. Here is a recap of these changes which are all reflected in
this release:

Form 500UP remit tax on all members' shares of income will now clear when entry has been
changed/removed on Maryland > General > Basic Data > Remit tax on all members share of income
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(Prepare Form 511). Also, Line 1 will pull the current year tax from Form 510 when this entry is changed to
"N" or removed.

Form 511 Line 2 will now include all state/local taxes from trade business, rental and/or farm income. An
override has been added on Maryland > Income/Deductions > Other Adjustments and Overrides > State or
local tax addback - override.

Maryland Form 510D, Lines 2 and 3 will now reflect the amount reported on Line 1 multiplied by the tax
rate for these lines times 110% when filing Form 511.

Maryland Schedule K-1, Line 2 will now reflect member's share of tax from Form 511, Line 7 or Line 9
depending on the member's type.

Maryland Schedule K-1, Section B, Line 5 will no longer include the member's share of state/local tax
addback.

Schedule K-1, Part D changes related to credit for tax paid by Electing PTE (Form 511) passed to another
PTE filing Form 510 or Form 511.

For a PTE filing Form 511 and receiving a credit from another PTE filing Form 511:

The credit is claimed on Form 511, Line 13c and not passed to the member's Schedule K-1,
Part D, Line 4. The member's Schedule K-1, Part D, Line 4 will now be blank in this case.

For a PTE filing Form 510 and receiving a credit from another PTE filing Form 511:

This amount is now reported on Form 510, Page 2, Line 16d. The member's Schedule K-1, Part
D, Line 4 will now show their portion of this credit. Schedule K-1, Part D, Line 1 will be
reduced by the amount reported on Line 4.

These additional updates have been made to Maryland:

1. State and local taxes based on income (trade/business, rental, farm) will now be included in
the calculation of Form 511, Line 2. An override for this calculation is available on Maryland >
Income/Deductions > Other Adjustments and Overrides > State or local tax addback -
override.

2. Schedule K-1, Part D, Line 2 will now be allocated on the member's share of tax reported on
Form 511, Line 7 or Line 9 depending on the member's type.

3. Per Maryland Administrative Release No. 6, Electing PTEs (Form 511) may not file a composite
return (Form 510C). Form 510C will now be suppressed if Form 511 is selected to be prepared
on Maryland > General > Basic Data > Remit tax on all members share of income (Prepare Form
511).

4. The due dates for PTE returns (Form 510, Form 510C, and Form 511) have been updated to
9/15/21.

5. Form 500UP checkbox to remit tax on all members' shares of income will now clear when Form
511 is not active in the return.

Please refer to the knowledge base article Updates to 2020 Maryland Form 511 in 1065 and 1120S returns
using CCH Axcess™ Tax and CCH® ProSystem fx® Tax for details.

Massachusetts
Form NRCR, Sch B now generates when Line 14 is filled from Sch C-2, Line 8.

Tax Product Updates • 15

https://www.marylandtaxes.gov/forms/Tax_Publications/Administrative_Releases/Income_and_Estate_Tax_Releases/ar_it6.pdf
https://support.cch.com/kb/solution/000132073/132073
https://support.cch.com/kb/solution/000132073/132073


Michigan
Forms 4908 and 4910 will be completed with all members on the combined return when the Michigan
Unitary Business Group Return Automated Feature is used by the designated member.

Minnesota
Form M8, Line 13 will fill with the payment amount(s) entered on Payments/Penalties/Estimates >
Payments > State Tax Payments > Payment and Code whether or not Code 2 is used.

Schedule KS changes include:

Line 16 now flows from Schedule KSNC, Line 24 when Schedule K, Line 13 is present.

Page 3, S Corp Name field matches the S Corp Name field on Page 2.

New Jersey
Form CBT-100U, New Jersey Corporation Business Tax Return, along with related Forms and Schedules, is
available for processing. The form must be electronically filed.

Additional input is required to produce Form CBT-100U for both the consolidating company
and the member companies.

The consolidating company must have input on Consolidated/combined return-override = "5"
(Produce combined return). Included member companies must have input on Member of a
consolidated/combined or affiliated group = "P" (Parent/Managerial Member) or "S"
(Subsidiary). This input is on the Federal > Common State/City > State and City Common Data
> Consolidated/Combined Return Information.

If input is not made on the consolidating unit, a group of CBT-100S returns will continue to
process as a group that will file as a New Jersey S Parent and one or more QSubs.

Our system does not permit one combined group to include members whose return is
processed on the C corporation system with members processed on the S corporation. If your
combined group includes C corporation members, contact support and request "conversion" of
an S corporation return to enable it to be processed on the C corporation system.

New Jersey CBT-160, Part 1, Line 7 now reflects only the amount of estimated taxes and prior year
overpayments from NJ sources.

New Mexico
For short tax years, short year dates now print correctly on Form RP-41367.

Ohio - Ohio Cities
The following city updates have been made:

Joining RITA From Independent

BR14 Bryan
BU03 Butler
GI01 Gibsonburg
RI07 Rittman
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Joining RITA From CCA

WE04 West Alexandria

Joining CCA From Independent

DA01 Dalton

Rate Change

CR03 Cridersville Effective 7/1/21
MI01 Midvale Effective 7/1/21
PO03 Powell Effective 1/1/22

New RITA City Codes

EV02 Evans Farm JEDD Effective 7/27/20
MI28 Milford JEDD VII Effective 2/1/21

Form CIN, Lines 13 and 14 will now factor in NOL when present in the return.

Oregon
Form BZT-V EST amounts will include the Heavy Vehicle Use Tax (HVT).

Rhode Island
Form RI-1096PT, Page 2, Line 5e shows the total of Lines 5a through 5d.
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Partnership (1065) Product Updates
Return to Table of Contents.

Federal
Form 3115. DCN codes 246 and 247 have been added to Part 1, Line 1a. Part II Lines 11, 12, 13, 15, 16, 17
and 19 are now blank when codes 246 or 247 are used, per Rev. Proc. 2020-50.

Form 8990. Floor plan interest is now included in the calculation of Form 8990, Line 6.

Georgia
Business credits with code 114J and 114M will now calculate the amount passed through to owners on Form
700, Page 4, Line 11.

Georgia Electronic Filing
Form IT RD. When an invalid telephone number is present, a disqualifying diagnostic will be issued.

Illinois
Illinois Schedule B. Foreign partners without a Social Security Number or Employer Identification Number
(EIN) are not required to enter an identification number in the software but will be able to file
electronically if all zeros are entered.

Maryland
Maryland Schedule K-1, Section B, Line 5 will no longer include the member's share of state/local tax
addback.

Schedule K-1, Part D changes related to credit for tax paid by Electing PTE (Form 511) passed to another
PTE filing Form 510 or Form 511.

For a PTE filing Form 511 and receiving a credit from another PTE filing Form 511:

The credit is claimed on Form 511, Line 13c and not passed to the member's Schedule K-1,
Part D, Line 4. The member's Schedule K-1, Part D, Line 4 will now be blank in this case.

For a PTE filing Form 510 and receiving a credit from another PTE filing Form 511:

This amount is reported on Form 510, Page 2, Line 16d. The member's Schedule K-1, Part D,
Line 4 will now show their portion of this credit. Schedule K-1, Part D, Line 1 will be reduced
by the amount reported on Line 4.

The following updates have been made to Maryland:

1. State and local taxes based on income (trade/business, rental, farm) will now be included in
the calculation of Form 511, Line 2. An override for this calculation is available on Maryland >
Income/Deductions > Other Adjustments and Overrides > State or local tax addback -
override.

2. Schedule K-1, Part D, Line 2 will now be allocated on the member's share of tax reported on
Form 511, Line 7 or Line 9 depending on the member's type.
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3. Per Maryland Administrative Release No. 6, Electing PTEs (Form 511) may not file a composite
return (Form 510C). Form 510C will now be suppressed if Form 511 is selected to be prepared
on Maryland > Income/Deductions > Other Adjustments and Overrides > Remit tax on all
members share of income.

4. The due dates for PTE returns (Form 510, Form 510C, and Form 511) have been updated to
9/15/21.

5. Form 500UP check box to remit tax on all members' shares of income will now clear when
Form 511 is not active in the return.

Mississippi
The beginning amount of qualified nonrecourse financing on Forms 84-132 will flow directly from each
partner's Federal Schedule K-1.

New Hampshire
Form NH-BET 'Total Gross Business Receipts for this business organization' line will no longer include
Federal Schedule F Line 1b.

New York
New York IT-204, Lines F1 and F2 will now include all partners, including those whose IT-204-IPs or IT-204-
CPs have been suppressed.

North Carolina
Form D-403V prints if there is a balance due in the return and no direct debit information is present.

Ohio - Ohio Cities
The following city updates have been made:

Joining RITA From Independent

BR14 Bryan
BU03 Butler
GI01 Gibsonburg
RI07 Rittman

Joining RITA From CCA

WE04 West Alexandria

Joining CCA From Independent

DA01 Dalton

Rate Change

CR03 Cridersville Effective 7/1/21
MI01 Midvale Effective 7/1/21
PO03 Powell Effective 1/1/22
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New RITA City Codes

EV02 Evans Farm JEDD Effective 7/27/20
MI28 Milford JEDD VII Effective 2/1/21

Pennsylvania - Philadelphia
Form NPT EXT is now present on the extension report when Federal > Extensions > Extensions > 1 - Federal
Extension Information > Line 17 is checked.

Tennessee
Tennessee estimate reminder letters no longer produce when Form FAE 172 is suppressed in the return.
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Fiduciary (1041) Product Updates
Return to Table of Contents.

Federal
Form 3115. DCN codes 246 and 247 have been added to Part 1, Line 1a. Part II Lines 11, 12, 13, 15, 16, 17
and 19 are now blank when codes 246 or 247 are used, per Rev. Proc. 2020-50.

Form 8990. Form 8990, Line 19 does not include the Unrecaptured Section 1250 Gain from passthroughs.
Only the Section 1231 gain/loss amount is included on Lines 12 and 19 of Form 8990.

QBI Loss Tracking Worksheet. The worksheet now prints with Forms 8995/8995-A if there are loss
carryovers, providing detailed tracking of those losses. When QBI losses and carryovers differ from the
activity, the differences show as NonQBI in Part II of the QBI Loss Tracking Worksheet to allocate the
allowed loss between NonQBI (Part II) and QBI (Part III).

Please note: The changes in calculation to follow the new instructions could potentially cause
changes in returns that have partially disallowed losses showing on the 8995/8995-A as well as
on the carryover worksheets. When carryover overrides are used, the QBI Loss Tracking
worksheet does not generate; the QBI Carryover Detail worksheet should be used instead.
Ordinary losses for Schedules C, E and F will be added on a future release. Column D of the
worksheet will not fill at this time for passthroughs, but will be added on a future release.

For more information, refer to knowledge base article 2020 1041 Fiduciary Return Form 8995
and 8995-A Changes.

Standard Filing Instructions. The Form 7004 mailing address will be present when the form is being filed.

State Schedule C, Line 16b no longer includes disallowed interest from a prior year for states that are not
conforming to the 8990 limitation of business interest.

Transmittal Letter.

Customization has been updated to present keywords in Return Configuration Set paragraph
customization.

Special paragraphs now print in state letters.

California
The accounting income calculation for California non-resident returns now includes apportioned non-
sourced income in returns where the sourced income is a loss.

Colorado
Transmittal Letters and Filing Instructions. The mailing address for Colorado returns with a balance due is
now included in letters and filing instructions.

Idaho
Idaho Schedule K-1, Line 21, Column B now takes the beneficiaries' percent times the amount from Form
66, Schedule B, Line 3. Schedule K-1, Line 24, Column B now takes the beneficiaries' percent times the
amount from Form 66, Schedule B, Line 8.
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Illinois
Beneficiaries >10. If Beneficiary Information > Beneficiary Summary Detail > 4. State K-1 Information >
State tax withheld is used for tax distribution to Schedule K-1 for Illinois then the amount that will show on
Form IL-1041, Page 3, Line 59 is the amount of total tax in return less the distribution totals.

Schedule 1299-D CF shows the tax calculation from Form IL1041, Line 44 to reflect the amount of used
credits.

Minnesota
July 2021 Tax Law Changes - conformity to federal

We've received updated forms for the tax law changes updated 7/01/2021 and program updates are in
progress. Minnesota has requested taxpayers not amend their return unless instructed by them to do so.

For more information: https://www.revenue.state.mn.us/tax-law-changes

South Carolina
The 1041V will no longer automatically print for paper returns that are sending payment with the return.
For payments that will be sent separately from the return, an option has been added on South Carolina
Income/Deductions > Other Adjustments, Taxes, and Credits > Print 1041V field to print the voucher.

Tax Product Updates • 22

https://www.revenue.state.mn.us/tax-law-changes


Exempt Organization (990) Product Updates
Return to Table of Contents.

Federal
Amended statement input has been added to Federal > Other returns > Form 4720 > Amended information
section.

Automatic change codes entered on Other > 3115 - Change in Accounting Method > Automatic Change
Request > Automatic change number will now display the 3 digit number.

Form 8879-EO for Form 4720 will now produce when the return is qualified or disqualified.

Input has been added on Federal > Unrelated Business Tax > Sch E, pg 2 1065/1120S > Activity > Form 4797
ordinary gain(loss) to enter Form 4797 ordinary gains and losses.

No correction statement will no longer show blank when information is present.

Part III Line 2 is no longer limited to zero and Line 4 is limited to zero to prevent reject F990T-032.

Part VII will now print a "see statement" when there are more than five entries.

The contributions statement will no longer show negative taxable income after the 60% deduction.

The passive loss amounts along with prior year amounts will now show as non-passive losses when the
option for 100% disposal is used on the K-1 input.

Electronic Filing
The 8879-EO (4720) will now produce when Form 4720 is selected for electronic filing.

California
Form 5806 exception C will now calculate when requested.
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Employee Benefit Plan (5500) Product Updates
Return to Table of Contents.

Federal
Diagnostic 40362 is issued when an invalid EIN is entered.

Diagnostic 40611 is issued when input for administrator's or DFE's signature information for Form 5500-EZ is
entered when only sponsor's signature information should be present.

Diagnostic 44074 is issued when Schedule SB, Line 33-date is blank and Line 33 contains an amount.

Form 5500-EZ, Lines 6a and 6b print zero when input of zero is entered.

Plan characteristic code, 3E, does not apply to Form 5500-SF and no longer carries to Line 9a.

Schedule SB, Line 3(c)2 carries from the Schedule MB/SB - Actuarial Information > Basic Information > RPA
'94 Information (subsection) > Vested benefits - Vested funding target column.

Sponsor's signature name and date, or sponsor's manual signature name and date, now carry to Form 5500-
EZ signature line.
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Estate & Gift (706/709) Product Updates
Return to Table of Contents.

Illinois
The following final Illinois form is available for dates of death in 2021:

Form 700
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